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Release Notes for RobotStudio 2021.2

General

The release name is RobotStudio 2021.2 and the build number is 21.2.9526.0. The release date is July 1,
2021.

User documentation

The RobotStudio Operating Manual is available in all languages except Czech, i.e. English, German,
French, Korean, Chinese, Japanese, Spanish. A selected set of RobotWare manuals are available. Each of
them is available in two versions, one for IRC5 and one for OmniCore.

Tutorials

Tutorials are available at the RobotStudio product pages at http://www.abb.com/roboticssoftware.

System Requirements

Required Software

Microsoft Windows 10 Anniversary Edition or later, 64-bit edition, is required.

The Windows AppInstaller is a pre-requisite for the virtual OmniCore FlexPendant software, see
https://www.microsoft.com/en-us/p/app-installer/9nblggh4nns1. The App Installer is a default built-in
app in Windows 10, but may have been removed on some PCs.

Sideloading of apps must be enabled on Windows 10 to install the virtual OmniCore FlexPendant, see
below:
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Recommended Hardware

ITE M RE QUIRE ME NT

CPU 2.0 GHz or faster processor, multiple cores recommended

Memory
8 GB minimium
16 GB or more if working with large CAD models

Disk 10+ GB free space, solid state drive (SSD)

Graphics
Card¹

High-performance, DirectX 11 compatible, gaming graphics card from any of the leading vendors.
For the Advanced lightning mode Direct3D feature level 10_1 or higher is required.

Screen
Resolution

1920 x 1080 pixels or higher is recommended

Mouse Three-button mouse

3D Mouse Any 3D mouse from 3DConnexion, see http://www.3dconnexion.com.

Virtual
Reality
Headset

Oculus Rift, HTC Vive or any Windows Mixed Reality Headset. Note that special PC hardware
requirements apply when using RobotStudio with VR, see https://www.oculus.com/oculus-ready-
pcs/, https://www.vive.com/us/ready/, or,
https://www.microsoft.com/enus/windows/windows-mixed-reality-devices, respectively.
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¹ RobotStudio will not benefit from the additional features of so-called ‘Professional’ or ‘Workstation’
graphics cards. The price level of these are at a much higher range than gaming graphics cards with
comparable performance. High-end gaming PCs are very suitable for offline programming with
RobotStudio. Such a PC will provide good performance for a limited budget.
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What's new in RobotStudio 2021.2

Add physics behavior to the 'Saved State'

Always show login dialog when connecting to a controller

Change Distribution when Edit a system in Installation Manager

Check certificate also when connecting to controller over management port

Create system folder for Installation Package on the root of a USB stick

Improved texts for new virtual systems in Installation Manager

Installation Manager now use the same location to unpack RobotWare as RobotStudio

IP Address number field

IRB 920T (IP30)

Log in to the system on the Service port

Migrate RobotWare removed

OPC UA Client configuration dialog

Select and add several Licenses at the same time

Select Distribution package when creating a virtual system based on existing system

Show used Distribution in Installation Manager

SLP Distributor: Clarify firewall exceptions

Add physics behavior to the 'Saved State'

The physics behavior of selected objects can now be included when saving and restoring the state of a
station or a Smart Component.
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Always show login dialog when connecting to a controller

The user is always prompted to login to the controller when connecting. RobotStudio no longer logs in
automatically with default credentials.

Change Distribution when Edit a system in Installation Manager

It is now possible to select and change Distribution package in the Distribution tab when you edit a
system in Installation Manager 7.

Check certificate also when connecting to controller over management port

When connecting to an OmniCore controller, the certificate for secure communication is verified
regardless of connection method. Earlier this was not done when connecting to the management port.

Create system folder for Installation Package on the root of a USB stick

Installation Manager 7 will now create a system folder if you create an Installation Packge on the root on
an USB stick.

Improved texts for new virtual systems in Installation Manager
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The texts to describe how to create new virtual systems in Installation Manager 6 & 7 have now been
changed. We now say that the system is based on another Virtual System or Backup. It is not a copy of
the system, it is just a system with same products and settings.

Installation Manager now use the same location to unpack RobotWare as RobotStudio

Installation Manager 6 and 7 now use the same location to unpack RobotWare products for virtual
systems as RobotStudio. In this way we get just one setting and will get all products in the same place.

IP Address number field

IP, Subnet Mask and Gateway address number field has been added to I/O Engineering to give the user a
more friendly way to type in the network addresses for both the robot controller and for the PROFINET
devices.

IRB 920T (IP30)

The IRB 920T (IP30) has been added to ABB Library. It can be used with a virtual controller running
RobotWare 7.3.

Log in to the system on the Service port

Installation Manager 6 & 7 will now select and log in to the only controller on the network when
connecting to the Service port.

Migrate RobotWare removed

The functionality for migration from RobotWare 5.x to 6.x is no longer supported and has been removed.

OPC UA Client configuration dialog

Setting up the OPC UA Client Smart Component has been made much easier with the addition of a new
configuration dialog. Use the dialog to browse the OPC UA nodes on the server and create new Smart
Component signals using drag-and-drop.
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Open the configuration dialog by selecting "Configure..." in the context menu of the OPC UA Client
Smart Component.

Select and add several Licenses at the same time

It is now possible to select and Add several licenses in the same time in Installation Manager 6 and 7.

Select Distribution package when creating a virtual system based on existing system

It is now possible to Select Distribution when you create a virtual system from another VC or Backup
and need to replace unresolved products.

Show used Distribution in Installation Manager

Installation Manager 7 will now try to show used Distribution package in system overview for selected
system.

SLP Distributor: Clarify firewall exceptions

The SLP Distributor installer has been modified to clarify the requirements for firewall exceptions.
The user must explicitly request to open the required ports in the Windows Firewall.
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When the installation has finished, the user can select to automatically launch the administration web
interface.
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Corrections

PDD

12834

Problems with synchronization

Fixed an error in Synchronize to Station that could occur when the path to be synchronized contained
references to installed RAPID symbols.

13187

Prevent creating unallowed system input/output

Fixed an issue in the Configuration editor, where it was possible to create an instance with invalid
empty attribute values.

13449

Visual SafeMove: CIP Safety Signal Offset field automatically updated when typing

It used to update the new signal with the lowest available unused device map e.g. 
name deviceMap
s1        1
s2        5
If you create a new signal it will get device mapping 2. It is now changed so the new signal will get
device map 6.

13459

System from layout - Bad task frame position

Fixed an issue where the task frame would end up at the local origin of the track mechanism instead of
the track base frame. 
This happened when the user clicked Finish from the first page of the wizard.

13461

Incorrect warning message when unpacking Pack & Go file to deep folder structure

A Pack & Go file with a deep folder structure could sometimes cause an incorrect warning regarding the
target path length in Unpack & Work. The calculation of the path length has been corrected.

13462

Visual SafeMove:Import protected elements erases Global Signals

Fixed an issue where Post logic expressions were missing after importing protected elements. The
issue occurred when two logic expressions referenced the same global input signal. The two global
signals were removed and the two expressions were merged together.

13472

Collision log in Signal analyzer is lost

Improved the validation of the time stamp of I/O and motion events from the virtual controller. Invalid
time stamps could cause errors like missing events in Signal Analyzer.

13477

Visual SafeMove:Possible to load safety configuration from a robot with 997-4 to a robot with 997-3

It is no longer possible to load a configuration with external CIP Safety devices on a system which
doesn't have option "997-4 CIP Safety Scanner and Adapter".
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13478

RobotApps missing "Published" date

The Published date for RobotWare and RobotWare Add-ins is now displayed in RobotApps.

13479

Deleting a tag deletes the object selected in the Layout tab

Fixed an error in the Tag browser that could cause a station object to be deleted when a tag was
deleted.

13501

Installation Manager 7, not able to modify system

Correction of Installation Package path have been done since this has been removed from the
Preferences window.

13514
Visual SafeMove: Wrong direction icon in Function Mapping for EmergencyStopActivated

The EmergencyStopActivated is now an output and writes to the connected signal.

13540

Incorrect stopping distance trace when using TCP trace

A bug has been fixed causing RobotStudio to incorrectly draw a stopping distance trace when the
robot switches workobjects during its path.

13559

Exception when trying to load a module from HOME in controllers with RobotWare 7.2

The command "Load in Task" used to load a RAPID module from the controller file system failed for
controllers with RobotWare 7.2. This has been fixed.

13567
Collision avoidance for IRB1300 missing in RobotStudio

It was not possible to configure Collision Avoidance for an IRB 1300 robot, this has been fixed.

13575
IRB 5500-27 orientation in Online Monitor

The orientation of IRB 5500-27 in Online Monitor has been corrected.

Visual SafeMove:SafeRange visualization is misplaced for link 6 for several robot models

The SafeRange is no longer misplaced in the graphics.

PDD
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Visual SafeMove: Difficult to show zones and tool when violation is active

When a violation is selected, only the violated geometry is visible. It was difficult to understand how to
deselect the violation to be able to see all geometries. In previous release a notification area was
introduced where it was possible to click and deselect the the violation. Now this is improved by a
better text that explains this behavior, se below:
"
Visual SafeMove violation selected. Only violated geometry is displayed. Click here to deselect the
violation
"

Visual SafeMove: Units in error message is not correct for Tool- tooldata- position x, y, z

The error message for Tool- tooldata- position x, y, z flange coordinates are now in correct units. 

Visual SafeMove: CBC and Stop configuration status should be stated in report when disabled

The report now shows that CBC is inactivated if it is not used.

Visual SafeMove:Report is incorrect for controller with only Industrial Network option selected

When only the Industrial networks options is present drive modules are no longer displayed.

Visual SafeMove: Logic expression name which does not exist shows up in protected elements
window

Internal logic expressions were visible in the protected elements window. They are no longer visible.

Visual SafeMove: No signal name in Write to controller disabled reason

The following improvements has been done to Visual SafeMove in order to better manage invalid signal
names:

The disabled reason for the Write to controller now button shows the name(s) of any invalid
signal(s).
Invalid signals can no longer be created using the pre or post logic editor in Safe IO Configurator.
If an old configuration file with invalid signal names is loaded, such signals are now shown as
invalid in the Safe IO Configurator.

No reconnect attempt at station load for OPC UA Client Smart Component

Only one connection attempt was done at station load if "Auto connect" was enabled for the OPC UA
Client Smart Component. Now the Smart Component attempts to connect to the OPC UA server every 2
seconds until it succeeds. Information about the connection status was also added to the Output
window.

Visual SafeMove:Show labels are getting enabled after every controller restart

Hidden labels now remains hidden after a controller restart.

Not possible to attach part to robot by drag-drop

Corrected an error that made it impossible to attach a part to certain robot links by drag and drop.

PDD
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New naming for OmniCore controller restarts

When restarting an OmniCore controller, the names of the different restart modes have been adjusted
to match the FlexPendant.

Unhandled exception in Signal Setup

Fixed an unhandled exception that happened when clicking the left arrow key after selecting a tree
node in the Signal Setup window.

Unhandled exception in Synchronize to RAPID window

Fixed an unhandled exception that could happen when starting a drag and drop operation inside a text
field in the Synchronize to RAPID window.

Freehand jog IRB 369C1 works incorrectly for axis 5

Corrected the behavior of freehand jog for IRB 369C1 axis 5.

Manual Mode missing in Path Return Region CFG Type

Fixed an issue in the configuration editor that could cause the name of certain configuration entries to
be displayed incorrectly.

Correction when deselecting options in Installation Manager

When deselecting an option the dependency childs in the manifest will no longer be selected in
Installation Manager 6 and 7.

Timeout error when installing FlexPendant app

Fixed an error that occurred when installing dependencies required by the FlexPendant app.

Visual SafeMove: Exception on trying to encapsulate upper arm

When clicking Encapsulate upper arm, an exception occurs if a stop configuration is selected. This has
now been fixed.

I/O Engineering Tool: Default Layout will not bring back all default windows

The Signal Editor window is now restored when selecting the default window layout in I/O Engineering
Tool.

Visual SafeMove: Signals not deleted when deleting CIP safety device

If a CIP safety device is deleted its signals is now also deleted.

Recording Playback: Wrong category 0 stop position for IRB 14050

In Recording Playback, category 0 stop position was incorrectly displayed for an IRB 14050
robot. Category 0 stop signals are no longer added when selecting "Quick add position signals" for IRB
14050, because the robot only supports category 1 stop.

PDD
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TCP Trace: category 0 stop trace is wrong for IRB 14050

In TCP Trace it is no longer possible to select category 0 stop trace for IRB 14050, because the robot
only supports category 1 stop.

IRB 14050 - Playback of Category 1 stop position not correct

In Recording Playback, the visualization was incorrect when selecting Category 1 stop position for an
IRB 14050 robot. This has been fixed.
Note that Category 0 stop is not supported for IRB 14050.

Visual SafeMove: CIP Safety External Devices can't be deleted

The external safety device reappear if the Safe IO Configurator window is closed and then opened. This
is now fixed

Wrong translations

Fixed a number of translations that were in the wrong language.

PDD

© Copyright 2021 ABB. All rights reserved. 15/29



Known Limitations

Visual SafeMove

Configurations with Basic Joint Supervision disabled can be created

For SCARA robots, like for example IRB 920T, only the limited functionality Basic Joint Supervision is
supported by the Safety Controller. Visual SafeMove allows the full set of functionality to be configured
even though it is not supported. Writing a safety configuration file with Basic Joint Supervision disabled
results in an error since it is invalid. Workaround: Enable the option Basic Joint Supervision on the robot
node in Visual SafeMove.

Current joint values cannot be retrieved when external axes are included in the configuration

It is not possible to retrieve the current joint values using the Read current values function on the
Synchronization node when external axes are included in the configuration. Workaround: Read the
values from the FlexPendant and update manually.

The safety controller is not forwards compatible

When writing a safety configuration file of a later version than the current safety controller image, then
RobotStudio will generate an error of type “C00FFFE: Unknown error
(0xC004FFFE)LoadSafetyConfigurationFile”. (Note that this error may occur for other reasons as well
and is thus not unique to this case).

The function Get vectors from active tool reads values from the robot

The idea behind this function is to to read the data from the currently active tool of the robot in order
to define a corresponding SafeMove Tool in the safety configuration. That is the reason why the tool
information is read from the robot and not the safety controller. The tools of the safety configuration
are visible the Visual SafeMove itself and does not need a special function to be retrieved.

Protected checksum may change when upgrading RW from 6.04.0x to 6.05 or 6.06

The protected checksum will change if the input and output modules of the internal device is protected.
The reason is that two attributes change order.

No visualization of Safe Range for external axes in Visual SafeMove for SafeMove Basic or Pro

When Safe Range is used to limit the axis range of an external axis such as a track motion, there will be
no visual indication of the actual range in the graphic view.

Visual SafeMove windows can be re-opened from the Quick Access Toolbar menu

Any windows that are closed can be re-opened using the Quick Access Toolbar menu, as the command
Default Layout does not recover these windows.

SafeMove Tool Zone visualization in Online Monitor for robots with external axes

Only TCP robots and track mounted robots will be visualized in the Online Monitor, no other external
axes or positioners. As a consequence, the Online Monitor may show the robot in a non-violating
position, even though the safety controller has detected a safety violation and stopped the robot.

IO Configurator 6

*Safety configuration problem with PROFIsafe Controller or CIP-Safety scanner

Changing safety settings in Visual SafeMove or IO Configurator 6 does not always work in conjunction
with the "PROFISafe controller" or "CIP-Safety Scanner" option. Connection with robot controller can be
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lost during any IO-configuration, sometimes resulting in that the Flex Pendant reboots. Again this is only
applicable when the PROFISafe controller or CIP-Safety scanner option is present in the system. Problem
is dependent on how many devices are configured on respective industrial network. I.e. EtherNet/IP or
ProfiNet.

Online

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the
dropdown menu of the task node in the Controller browser. This is due a restriction introduced with
RobotWare 5.60 and later.

Individual RAPID tasks cannot be stopped for RobotWare 5.60 and later

When running multitasking systems, it is not possible to start and stop individual tasks with the
dropdown menu of the task node in the Controller browser. This is due a restriction introduced with
RobotWare 5.60 and later. However, from RobotWare 6.03 onwards, then RAPID tasks to execute or to
stop can be selected from RobotStudio RAPID tab.

FlexPendant Viewer running with automatic reloading

When having FlexPendant Viewer running with automatic reloading of the screens and at the same time
jogging the robot with the joystick the robot jogging might halt when the FlexPendant Viewer reloads.

Online – Paint

Backup for Paint systems does not create backup of the PIB for IRC5P with RobotWare 5.xx

The Backup function of RobotStudio does not create a backup of the PIB board of the IRC5P system
when running RobotWare 5.xx. Workaround: Create the backup of the PIB board with the FlexPaint
Pendant using an USB-stick.

Go Offline does not work for Paint systems

The Go offline function will not create a working Virtual controller system for Paint system unless the
Paint package I/O option is set to Simulated.

Online – Integrated Vision

Installation error when having previous versions of RobotStudio or Insight Explorer

If you have a previous version of RobotStudio or Cognex In-Sight software installed, installing a new
version of RobotStudio may result in the following error message

Module C:\Program Files (x86)\Common Files\Cognex\InSight\5.7.1674.0\CvsInSightDisplay.ocx failed
to register. HRESULT -2147220472. Contact your support personnel.

Workaround: To correct the issue, open Windows Settings -> Apps -> Apps & features, select the
current ABB RobotStudio 2019.x, select Modify, and step through the installation wizard and select
Repair. Alternatively, uninstall and reinstall RobotStudio.

Note: Only one version of the In-Sight Display Control can be registered at a time, and this is always the
latest version installed. Although older versions of RobotStudio or In-Sight may seem to function with
this version installed, their compatibility with this version is not guaranteed.

RobotStudio may hang for up to 60 seconds when configuring jobs with PatMax 1-50

The user interface of RobotStudio may freeze for up to 60 seconds when configuration Integrated
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Vision jobs with the tool PatMax 1-50.

Workaround: Use PatMax 1-10 instead

Remaining error – New Emulators

New camera models have been added to the camera emulator option in RobotStudio 6.04.01. Some of
these new models are not yet fully compatible. Our recommendation is to choose a camera model from
the 7000 series which is fully compatible with Firmware version 4.10.2.

Emulated cameras not discovered when controller in Motors On

For RobotWare 5.61 onwards, the camera discovery mechanism is disabled when the controller is in
Motors On. As a consequence, the camera nodes will not appear in the controller browser.

Workaround: Switch to Manual Reduced Speed and use the Refresh command on the Integrated Vision
node in the browser to make the cameras appear.

Information – Camera firmware version and update

The minimum firmware version to be used with Integrated Vision is 4.08. If this version is not available for
a specific camera model, then the newest version available shall be used. There are two important things
to know before upgrading a sensor:

The user must make sure to first backup the files on the camera. This can be done using the Rapid
snippets for camera backup/restore, or the FlexPendant Explorer.
The latest available firmware version may vary across sensor types. However, when the firmware
update utility presents the latest available version it shows the firmware with the highest version
number which may not apply to the sensor to be updated. However, the appropriate firmware will
be applied.

Information – The spreadsheet view

The spreadsheet view is not enabled when editing in the in the following modes “Add part location tool”,
“Add part inspection tool”. Before entering the spreadsheet mode click for example “Setup Image” or
Output to Rapid.

Information – Calibration board without fiducial

When using the calibration boards, checkerboard or board with dots, the user must select the preferred
origin by clicking and accepting (press enter) three points on the board. Only after these three points
have been selected it is possible to click "calibrate" to execute the calibration.

Information - Use default camera settings

If the camera is not using default communication settings the result may be that RAPID instructions
return error code “Communication Error”. The safest method to get default settings is to go to
Connect->Add Sensor Right click and select “Show all sensors”. Select the device to reset and click
“Apply factory settings” in the lower right corner. The most important settings are:

Telnet port: 23
User: "admin"
Password: ""

Information – User Credentials

It is now possible to create user profiles with different access levels on the camera. For detailed
information about this, please refer to the Integrated Vision User Manual.
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Remaining error – Save image on camera

It is not possible to save an image on the camera using “Save Image”. This is by design, but the dialog
still allows the user to try to do this. The result is that the image is not saved and no error message is
given.

Remaining error - Connect button greyed out for no reason

It may sometimes happen that the “Connect” button is greyed out, with the tooltip saying the camera is
not on the correct subnet although the IP settings are OK.

Workaround: Restart the Integrated Vision Add-In

Remaining error – VC started from Controller->Add controller does not detect cameras

A VC that is started from Controller->Add controller does not detect cameras on the network, even if
the VC_network_definition.xml is correctly configured and the firewall is turned off. The reason is that
the controller is not able to detect new cameras on the network when it is in “Motors On” state. When
the VC is started stand-alone in RobotStudio it is automatically set to “Motors On“ when started.

Workaround: To allow it to discover cameras, turn the control panel key to manual mode or launch the
VC as part of a station.

User tip - Removing cameras from configuration

To remove a configured camera from the list of configured cameras, use the configuration editor. Enter
Configuration->Communication->Application Protocols and remove the desired camera. Perform a
warm start to complete the operation.

User tip – Viewing all cameras present on the network

Connect->Add Sensor is normally used for setting the IP addresses of sensors that are not currently on
the correct subnet (192.168.125.X). Since the dialog shows all cameras “seen” by the PC, this dialog is
useful when error tracing camera network problems. If a camera does not appear on the network using
the “Add sensor” dialog as suggested above, it is advisable to cycle the power of the camera. If the
camera receives power from the controller, then cycle power by turning the mains switch.

User tip – Warm start the controller after changing network settings

Whenever changing the network settings of the camera, either from Connect->Add Sensor or Connect-
>Network settings, it is important to warm start the controller. If this is not done, RAPID instructions will
give the error “Communication Error” and the FTP-mounted camera disk is not accessible. If DHCP
address is used and persist, please try a static address instead.

Offline

Point cloud data in JT files can't be imported

Point cloud data in JT files is not imported by RobotStudio.

Issue with collission avoidance for palletizer robots

When configuring collision avoidance for a palletizer robot using RobotWare 6.11, attaching an object to
a mechanism link can result in an error and the configuration will not be loaded.

The YuMi library revision 1 cannot be successfully updated to YuMi revision 2

When opening a Pack&Go file with a station that has a reference to IRB14000_0.5_0.5__01.rslib  you
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get the option to update it to the newer IRB14000_0.5_0.5__02.rslib .

The following issues occurs if you select ‘Yes’ and update the model:

The attached parts, for example Smart Grippers, are detached.
The new YuMi robot is not connected to the virtual Controller.
The old YuMi mecanism is converted to a component.

Answer ‘No’ to this question to keep the original revision 1 model and avoid the problems mentioned
above.

RobotStudio needs to be restarted to update a modified library instance

When editing a library file (.rslib) that is used in a currently open station, then RobotStudio needs to be
restarted to update the library. Simply re-opening the station is not enough to update the content of
the station. Unless RobotStudio is restarted, the old library instance will remain in memory and be loaded
even though the underlying file has been updated. This is a known limitation and is expensive to fix.
There is a workaround to the problem, which is to restart RobotStudio.

The robot IRB 1600ID 1.55 m / 6kg replaced by IRB 1660ID1.55 m / 6 kg in RobotWare 6.04

The robot IRB 1600ID 1.55 m / 6 kg is not available in RobotWare 6.04 and later. It has been renamed to
IRB 1660ID 1.55 m / 6 kg. Virtual controller systems for IRB 1600ID 1.55 m / 6 kg based on RobotWare 6.03
cannot upgraded to RobotWare 6.04 and later. This means that Pack&Go files for this robot based on
RobotWare 6.03 cannot be upgraded to RobotWare 6.04 automatically

Workaround: Re-build or modify the virtual controller system to use IRB 1660ID 1.55 m / 6 kg instead
when using RobotWare 6.04 or later.

FlexPendant and RAPID applications run with logged in user rights

A FlexPendant or RAPID application running on the virtual controller runs with the rights of

the logged-in Windows user. RAPID applications running in a background task will start to execute when
the Pack&Go file is opened and FlexPendant applications will start to execute when the user starts the
Virtual FlexPendant. A warning message has been added to the Unpack&Work wizard to make the user
aware that only Pack&Go files (.rspag) from trusted sources shall be opened.
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Compatibility of RobotStudio Library and Stations with older RobotStudio versions

RobotStudio is generally not forwards compatible, i.e. it is not possible to load stations or libraries
created in RobotStudio 6.04 into an earlier version of RobotStudio such as e.g. RobotStudio 5.x, 6.03.02
or earlier. However, RobotStudio is backwards compatible, which means stations and libraries created
in versions 5.x, 6.03.02 or earlier can be opened in RobotStudio 6.04

TrueMove path visualization fails for customized zone data

The TrueMove path visualization function only supports predefined zonedata. It will not work for user
defined zonedata.

Backup fails for RobotStudio solutions with SafeMove or Electronic Position Switches

Backups are automatically created for virtual controller systems that are part of a RobotStudio solution
when saving the station. For virtual controller systems with the RobotWare options SafeMove or
Electronic Positioning Switches the backup will fail since these systems contain files that are read-only.
As a result, an error message is presented in the output window: <System name>: Backup failed . The
station will be successfully saved but there will be no backup created. Workaround: Ignore the error
message <System name>: Backup failed  and create a manual backup whenever needed. The
RobotStudio Option “Enable automatic backup of controllers in solution” that is available in
”RobotStudio Options -> Robotics -> Virtual Controller” can be de-selected to disable the backup
function.

IRB 14000 cannot be combined with any other robot

The function system from layout fails if trying to create a MultiMove system where one robot is an IRB
14000. The reason is that the IRB 14000 cannot be combined with any other robot.

Workaround: Create a separate system for the IRB 14000.

The Work Envelope function does not support IRB 14000

The function is disabled for the IRB 14000 and cannot be activated.

The 2D work envelope fails for certain robot models
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As a result, the generated work envelop may appear distorted.

Update of current selection in the 3D graphics window may be delayed

A problem related to the graphics driver has been observed on certain PCs. The problem is that the
update of the current selection in the 3D graphics is delayed until the next redraw.

Workaround: Add or uncomment the following line in the file RobotStudio.exe.config

<add key=”DoublePresentWorkaround” value=”true” />

Failure to open Pack&Go file to same folder the second time

RobotStudio will prevent Pack&Go files to be opened to the same folder a second time if the station
contains VC systems with the EPS or SafeMove option. This is by design to prevent the safety controller
configuration file to be accidentally overwritten.

Workaround: Remove the write protection manually using Windows Explorer.

Updates of instruction template and code snippets

RobotStudio will not automatically update the user files for instruction templates and code snippets
files in the folders:

…\My Documents\RobotStudio\Instruction Templates
…\My Documents\RobotStudio\Code snippets

Workaround: The user has to manually copy the latest files from

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Instruction Templates

and

%ProgramFiles%\ABB Industrial IT\Robotics IT\RobotStudio 5.xx\Code Snippets

to the data folder.

I/O signals configured with access level 'DEFAULT'

When IO signals are configured with access level 'DEFAULT', only input signals are possible to set/reset
from the I/O Simulator and I/O Window. To be able to affect also output signals, set the access level to
‘ALL’ for them in the Configuration Editor.

VC does not start with RRI option and GSI folder structure missing

The VC will hang when started with a system containing the RobotWare option RRI (Robot Reference
Interface) if the GSI folder structure is missing.

Workaround: Create GSI Folder before starting the VC inside the HOME directory of the system. See the
Application Manual for Robot Reference interface for more information.

System in Guard Stop state in Automatic mode after run-time error

Certain run-time errors may cause the controller system to enter Guard Stop state in Automatic mode.
This is the same behavior as in a physical robot controller system. This typically happens when a run-time
error related to Conveyor Tracking occurs. A simulation cannot be started when the controller is in this
state.

Workaround: To reset the controller state, open the Control Panel window and first switch to Manual
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mode, and then back to Automatic mode.

Path handling of instructions with multiple joint targets

The path functions Rotate, Translate, and Mirror do not work as expected with instructions containing
via points as jointtargets. The functions will leave the jointtargets as is. Interpolate Path gives an
Unknown Error and Tool Compensation reports an error message.

Event Manager: Simulation cannot be triggered by analog system signals

The event manager only supports analog station signals, not analog system signals.

Conveyor Tracking

*Conveyor objects must be re-added for stations created prior to RS 6.05

When opening stations with conveyor tracking created prior to RobotStudio 6.05, conveyor objects
must be re-added.

Incorrect default values for c1Position and c1Speed for RobotWare 5 with the PaintWare option

The default values for the parameters c1Position and c1Speed may become incorrect for a virtual
controller system. The symptom is that its attribute values are all zero, see snapshot below.

Workaround: Save the following lines to a CFG file named ‘TEMP.CFG’ or similar and load in the virtual
controller followed by a restart.

EIO:CFG_1.0:5:0::
#
EIO_SIGNAL:
 -Name "c1Position" -SignalType "AI" -Unit "CnvIf"\
 -SignalLabel "ctPosition" -UnitMap "0-31" -Access "ALL"\
 -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
 -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
 -MinBitVal -2147483647
 -Name "c1Speed" -SignalType "AI" -Unit "CnvIf" -SignalLabel "ctSpeed"\
 -UnitMap "32-63" -Access "ALL"\
 -MaxLog 21474.8 -MaxPhys 1 -MaxPhysLimit 1\
 -MaxBitVal 2147483647 -MinLog -21474.8 -MinPhys -1 -MinPhysLimit -1\
 -MinBitVal -2147483647

MultiMove

MultiMove error: ‘Object reference not set to an instance of an object’

When the Test Play button is pressed in the MultiMove tool, the following error message may be
displayed: ‘Object reference not set to an instance of an object’, but the robot moves and the Status
‘Calculation OK’ is displayed. In addition, when ‘Create Paths‘ is pressed the following message is
displayed: ‘Can't create paths : Value cannot be null’, and no paths are created. In the ‘Create Paths
Settings’, is the WP TCP drop down empty.

Reason: Workobject is not set for the current task.

External Axis

Error 50091: ‘Restart not possible’ after warm start of a system with external axis

When restarting a system with activated mechanical units the activation state is lost. Then the program
can no longer be started from the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window.

Workaround: Reset the program pointer (‘Program Pointer to Main’) before starting the program from
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the Virtual FlexPendant, the RAPID Editor or the RAPID Tasks window, or, start the program from the
Simulation Play button.

Network Drives and UNC Paths

RobotStudio on computers with roaming user profiles

RobotStudio may fail on PC configurations with roaming user profiles, i.e. when the users’ documents
folder resides on a server and not on the local disk.

Workaround: Redefine the ’User Project Folder’ to a folder on the local disk (File → Options → General →
Files&Folders → User Project Folder).

Virtual Controller does not support UNC paths

UNC paths cannot be used to locate Virtual Controller systems. Using UNC paths for VC systems will
cause the log message ‘Failed to initialize FW upgrade framework’ to appear when the system starts.
Subsequent attempts to work with the VC such as synchronizing RAPID data will fail.

Creating and starting systems located on a network drive

When using a network drive to store RobotStudio data such as RobotWare systems or the RobotWare
mediapool, the following problems may occur:

Virtual controller does not start
Not possible to open Virtual FlexPendant

Cause: By default, the .NET Framework does not allow execution of code from a remote file system. This
means the application may behave unexpectedly if the media used by the system or the system itself
resides on a network share.

Workaround: To resolve this, the user must explicitly grant the required permissions:

1. Open the file Virtual FlexPendant.exe.config located in C:\Program Files (x86)\ABB Industrial
IT\Robotics IT\RobotStudio 5.61\Bin

2. Add the following lines:

<?xml version="1.0"?>
<configuration>
    <startup useLegacyV2RuntimeActivationPolicy="true">
        <supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>
    </startup>
    <runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
        <loadFromRemoteSources enabled="true"/> <!-- THIS IS ONE OF THE NEW LINES!!! -->
    </runtime> <!-- THIS IS ONE OF THE NEW LINES!!! -->
</configuration>

The Virtual FlexPendant must be restarted for the changes to take effect. For further information, see
http://msdn.microsoft.com/en-us/library/dd409252(v=vs.100).aspx

RAPID

Robtargets that are LOCAL to a PROCEDURE cannot be synchronized with RobotStudio

The RobotStudio synchronization engine that translates 3D data of the station to RAPID code and vice
versa does not support robtargets that are declared locally to a procedure.

Workaround: Declare the robtargets as global or local to a module instead.
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Robtarget names must be unique in RAPID even if they are LOCAL

RobotStudio requires that robtarget names are unique for the RAPID synchronization to work properly,
i.e. you cannot have a global robtarget named pMyTarget1 in module A and a local robtarget with the
same name in Module B.

Global robtargets cannot be made local through Synchronization to VC

Global robtargets cannot be changed to local through Synchronization to VC, the option is disabled
(PDD 3140).

Workaround: Change the robtargets to module local in the RAPID Editor and Synchronize to station.

Error Message: Sync. to Station completed with errors

Error Message: Sync to Station completed with errors: New data name type has same name as existing
object in same block routine.

When this error message appears, there is a storage type mix-up between data already stored in RS and
in the VC. Because of this, and per design, the data is not considered the same data.

Workaround:

1. Ensure all data declarations have the same definition in RS as in RAPID (there is no user interface
for this).

2. Sync to station should now work.
3. Sync back to controller, and remember to change the data declarations back to what you want.

Paint

The new conveyor tracking module DSQC2000 is not supported for paint robots.

The new conveyor tracking module DSQC2000 is not supported for paint robots.

Lack of Virtual Controller support for the Paint systems

Paint systems that are configured using the Paint package I/O option Discrete, Compact or Fieldbus,
will result in a SysFail state.

Workaround: Re-create the system with the simulated I/O option.

Graphics and Geometry

*Display of working range optimized for furthest reach

The current algorithm uses a fixed value for joint five which gives the furthest reach for a given tool. The
sweep is not optimized to get the shortest reach on the "inside" of the working area.
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Enforce selected graphics device for PCs with multiple graphics cards

For best performance when running RobotStudio on a PC with multiple graphics cards, RobotStudio can
be configured to use a specified device. By this option you can ensure maximum performance. This is
useful for e.g. Lenovo W540 that has both an integrated Intel graphics device and a discrete NVIDIA
card.

Open the file RobotStudio.exe.config that is located in the folders

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin64

and

C:\Program Files (x86)\ABB Industrial IT\Robotics IT\RobotStudio x.y\Bin

and uncomment the line:

<add key="GraphicsDeviceType" value="Discrete"/>

Valid values are 'Discrete', 'Integrated' and 'Warp' (software renderer). Note that there are two different
files, one for the 32-bit version, and another for the 64-bit version.

Problems when undoing Boolean operations on Geometry

Undoing a Boolean operation might not succeed. To recover from these problems, you need to delete
the items that caused the problem.
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RobotWare Compatibility

Supported RobotWare versions

RobotStudio works with RobotWare 5.07 and later. Please check details below. The latest supported
RobotWare version for IRC5 and OmniCore controllers is stated under Help/About in RobotStudio.
RobotWare packages can be added to RobotStudio from the RobotApps window.

RobotWare 5.05 and 5.06 Compatibility

RobotWare 5.05 and 5.06 including revisions thereof are not supported by RobotStudio 5.15 and later
versions. Please use the corresponding version of RobotStudio for managing robot controllers with any
of these RobotWare versions.

RobotWare 5.07 Compatibility

General

The location of the program pointer is not updated in the RAPID Editor during program execution.

Offline

A limitation in the versions 5.07.02, 5.07.03, and, 5.07.04 of RobotWare may cause the Virtual Controller
to System Failure state during I-start on certain computers. The problem is due to the ctrl.bin-file not
being correctly created.
Workaround: Create an empty ctrl.bin file in the INTERNAL folder of the controller system, and then
perform a warm start.
Note: The problem will reappear if the system is I-started. The virtual controller does not support
RobotWare 5.07.08 and RobotWare 5.07.07.

Online

FlexPendant Viewer does not work RobotWare 5.07.

RobotWare 5.08 Compatibility

RobotWare 5.08 and its revisions of are supported with the following limitations:

Offline

RobotWare 5.08 is not supported.
Workaround: Use RobotWare 5.08.01 or later.

RobotWare 5.10 Compatibility

RobotWare 5.10 and its revisions of are supported with the following limitations:

Offline

Starting a controller will generate internal UAS error in controller error log.

RobotWare 5.11 Compatibility

RobotWare 5.11 and its revisions of are supported with the following limitations:

Offline

Linear jogging of a robot across joint values that will cause a change of confdata may fail. For example,
if the robot is jogged linearly when joint values is passing 90 degrees for axis 1 may cause the robot to
stop or to change configuration.
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RobotWare 5.12 Compatibility

RobotWare 5.12 and its revisions of are supported with the following limitations:

Paint

Paint backups from RW 5.12.01 are not compatible with RW 5.12.02 or later. Restoring a paint system
backup from RobotWare 5.12.01 will cause SysFail for RobotWare 5.12.02 or later.
Workaround: Add the following parameters to the configuration files:
EIO.CFG

EIO_SIGNAL:
-Name "doMainInMC" -SignalType "DO" -Unit "SysComm" -UnitMap "44"
-Name "A1HVErrNo" -SignalType "GO" -Unit "SysComm" -UnitMap "150-151"\
-Access "ALL"
-Name "A1HVEn" -SignalType "DO" -Unit "SysComm" -UnitMap "155"\
-Access "ALL"

EIO_CROSS:
-Res "A1HVEn" -Act1 "HVEnabled"

SYS.CFG:

CAB_TASK_MODULES:
-File "INTERNAL:/pntrapid/T_ROB1/cycinfo.sys" -ModName "cycinfo"\
-Task "T_ROB1"
-File "INTERNAL:/pntrapid/csvlkup.sys" -ModName "csvlkup" -AllTask \
-Hidden

RobotWare 5.13 Compatibility

RobotWare 5.13 and its revisions of are supported with the following limitations:

Paint

Paint backups from RW 5.12.02, 5.12.03 or RW 5.13 or 5.13.01 not compatible with RW 5.13.02 or RW
5.13.03. There are several changes in the configuration database for I/O (EIO.CFG) and Controller
(SYS.CFG) that will cause System Failure if an old backup is loaded. There are also changed in installed
RAPID modules. To create a compatible configuration, proceed as follows:

1. Create and start a VC with a RobotWare 5.13.03 system containing the same options as your
original backup, but do not load the backup.

2. Save the EIO.CFG and SYS.CFG to file.
3. Compare the saved files with the corresponding files of your backup. (You can use a text file

comparison tool for simplification.)
4. Add your system-specific configuration to the general configuration files saved from the 5.13.01-

system using a text editor.
5. Replace the files of the original backup with the corresponding modified configuration files.
6. Go through the RAPID modules of the backup and remove the default modules (i.e. those that are

not changed by the user).
7. Load the backup and restart the system. You are done.

RobotWare 5.15 Compatibility

Signal Analyzer Online

The feature Signal Analyzer Online requires RobotWare 5.15.03 or later.
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RobotWare 6 Compatibility

Overview

RobotWare 6.00 and 6.00.01 systems cannot be directly upgraded to RobotWare 6.01. To upgrade a
system, you need to create backup and migrate it using the tool ‘Migrate Backup or Folder’, then
recreate the system and finally, restore the backup. For this reason, the functions ‘Unpack&Work’, ‘Go
Offline’ and ‘New Solution with Station and Robot Controller – From backup’ are blocked to prevent
upgrade from RobotWare 6.00 or 6.00.01 to RobotWare 6.01. RobotStudio, however, is compatible with
both RobotWare 6.00 / 6.00.01 and 6.01.

General Compatibility Limitations

Safety Configuration

Safety configuration of a track motion IRC5 system equipped with a safety controller of type EPS or
SafeMove can be done without the need to read track motion parameters manually when using
RobotWare 5.11.01 or later. Encrypted parameters needed by the safety controller will be automatically
read by EPS Wizard and SafeMove Configurator, respectively.

Configurations

The feature Configurations for selecting the robot arm configuration (confdata) may fail, or not present
all solutions, in some specific circumstances even when the target is reachable if RobotWare 5.14 or
earlier is used.

Workaround: Upgrade to RW5.14.01 or later
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